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1 Introduction

How do muscles work and which components cause their contraction? This question was an
object of numerous investigations in fields of medicine, biology, and recently also (bio)physics.
Already in the 19th century many microscopic studies on the structure of muscles have been
conducted, focusing mainly on the stripe-like pattern - typical feature of the muscle tissue
(Fig. 1).

Stripes in muscle consist of alternating optically dense and less dense regions. The dense
regions are known as A-stripes, the less dense areas as I-stripes. The A-stripes have a charac-
teristic bright zone in the center called H-zone. Along the middle of the H-zone runs another
dark line. The I-strips are separated by the dark Z-line. Area between two Z-lines is a basic
unit of the muscle - sarcomere. A human biceps for example, contains at least ten million
sarcomeres (Fig. 2).

In the 40s it was found that adenosine-5’-triphosphate (ATP) is an energy source for
muscle contraction. For the first time it was shown that muscles are molecular machines that
convert chemical energy into mechanical energy. However, the role of ATP in living organisms
is much wider. It does not only provide the energy for muscles contraction but also serves
as an important energy storage molecule in living cells. Chemical energy becomes available
when ATP is enzymatically converted (hydrolyzed) into ADP and phosphate ion (fig. 3).
This energy can be used to drive biosynthesis, transport processes and perform mechanical
work. Every day about 65 kg ATP are repetitively synthesized and hydrolysed in human
body.

The next major scientific advance in understanding how muscles work was the identifica-
tion of the three proteins: actin, myosin and titin. These are the three main components
of the muscle that build the sarcomere and allow muscle contraction.

Figure 1: Microscope image of muscle tissue. The typical stripe-like pattern generated
by alternating I- and A-bands is visible.

1



Figure 2: Structure and dimension of muscle tissue in Drosophila and human.
Skeletal muscle consists of many myofibrils which span the whole length of the muscle. The
basic unit of each myofiber is the sarcomere with a length of approx. 3µm which is arranged in
A-bands and I-bands. The sarcomere consists mainly of the three proteins actin, myosin and
titin. Additional stability is provided by α-actinin and around 100 other proteins regulating
contraction (image taken from: Lemke 2016 ”Mechanical forces during muscle development”).

Figure 3: Chemical structure of ATP and ADP. Hydrolysis of the ATP to ADP releases
chemical energy stored in the pyrophosphate bond. 7.4 kcal are released per mole of ATP.
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1.1 Actin filaments

G-actin is a globular protein with a centrally located ATP binding site. If the binding site is
occupied by an ATP, multimerization of G-actin monomers occurs and an F-actin polymer is
formed (Fig. 4a, 4b). Critical G-actin concentration and presence of ATP is is necessary to
trigger the polymerization. At a lower G-actin concentration depolymerization of the filament
starts.

(a) Polymerization cycle of actin. (b) Formation of an actin polymer.

(c) The I-strip (fig. 2) consists mostly of actin filaments.

Figure 4: Actin and actin filaments.

A functional actin filament (Fig. 4c) consists of two coiled F-actin fibers and two tropomyosin
fibers. The tropomyosin fibers are located in the grooves between the F-actin fibers and con-
nected by troponin complexes. Actin filaments are the main component of sarcomere I-stripes.

1.2 Myosin motors

Myosin molecules are generally composed of a head, neck, and tail domain. The head domain
is a motor domain that binds the filamentous actin and uses ATP hydrolysis to generate
force and to ”walk” along the filament. The neck domain acts as a linker and as a lever arm
for transducing force generated by the catalytic motor domain. The neck domain can also
serve as a binding site for myosin light chains which are regulatory proteins. The tail domain
mediates interaction with other myosin subunits.

A myosin filament consists of about 200 single myosin II molecules, each one having
a molecular mass of about 490 kDa. Myosin II can be proteolytically cleaved into heavy
meromyosin (HMM; mero meaning ’part of’) and light meromyosin (LMM) by α-chymotrypsin.
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Heads of the heavy chains form a globular motor head domain while the tails two chains in-
teract to form an α helical coiled coil (Fig. 5a). Coiled tails of single myosin molecules are
winding in parallel and make up a backbone of the myosin filament. Myosin molecules attach
to each other in such a way that the myosin motor heads show up in in a regular manner on
the filament surface (Fig. 5b).

(a) Structure of the myosin II. (b) Structure of a myosin filament.

Figure 5: Myosin and Myosin Filaments.

1.3 Titin

Besides myosin and actin, titin plays a fundamental role in the ensemble of muscle proteins.
Titin is a giant protein with a molecular weight of about 3.6 MDa. It forms its own filament
structure which is stretched through half the sarcomer. One titin molecule has a length of
about one micrometer and is built from up to 300 globular protein domains. Most of the
titin domains bind to actin and myosin filaments, giving muscle its stability. The part of titin
which is not bound to actin and myosin provides muscle elasticity.

1.4 Sliding filament theory

At the beginning of the 1950s in vivo observations on frog muscle fibers with the interference
microscope showed a change from low to high optical density of the I-band during contraction
of the muscle. As explanation to this observation the sliding filament theory was postulated:
the contraction of the muscle fiber is based on a telescopic sliding of the myosin into the
actin filaments while the Z-discs approach each other. This leads to an increased overlap
of the myosin and actin filaments and therefore to an increased optical density. The sliding
movement is caused by the forces between actin and myosin chains.

The electron microscope images show that actin and myosin filaments are bond to each
other via heads of the myosin molecules. The finding that these cross bridges are responsible
for the ATPase activity of the myosin proved the sliding filament model. In absence of ATP
the myosin binds to the actin filament and adding ATP loosens these strong bonds.

In presence of actin myosin shows high ATPase activity, while myosin alone has rather low
activity. This is consistent with the idea of muscles acting as machines converting chemical
into mechanical energy.
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The mechanical activity of myosin, especially of the head domain, could first be observed
via X-ray diffraction on contracting muscles. The addition of ATP changes the angle between
the head domains and the actin filament from 45◦ to 90◦. This periodic change in orientation
of single myosin heads produces the forces which sum up and cause the sliding of the filaments
and consequently contraction of the muscle. A detailed description of the reaction cycle of
myosin is given below.

1.5 Myosin reaction cycle

1. In the initial state myosin is bond to actin via its head domain.

2. Binding of ATP loosens this bond.

3. The myosin head hydrolyses ATP to ADP and an inorganic phosphate ion (Pi). The
ATP dissociation leads to a tilt of the myosin head, the angle between the head domain
and the actin filament changes from 45◦ to 90◦C.

4. The myosin head forms a new bridge to the adjacent actin molecule. The actin causes
the release of the Pi ...
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5. ... and subsequent release of the ADP. This causes a conformational change of the
myosin head which acts like a power stroke. Now the next, adjacent active actin is
available for the next cycle.

This cycle can be repeated as long as ATP is present and the thick filament moves steadily
along the thin filament towards the z-disc. Every single stroke of the approximately 500 heads
of a thick filament contributes about 10 nm to the sliding with a repetition rate of about 5 Hz
during strong contraction.

1.6 Gliding assay of actin filaments

During this lab course we want observe the interaction between actin and myosin filaments
in vitro. For this purpose myosin molecules are bond to a functionalized glass surface. After
addition of ATP, free actin filaments are moved over the surface by these myosins (Fig. 6).
The analysis of the enzymatic activity of myosin is done using the Michaelis-Menten kinetics.
Kinetic data will be extracted from a video analysis of the free moving actin filaments. For
optical acquisition of the data we use a total internal reflection fluoresence (TIRF) microscope.

Figure 6: Schematics of the experimental concept. Fluorescently labelled actin filaments slide
on the surface being pushed by immobilized myosin molecules.

2 Theoretical background

2.1 Kinetics of enzymatic reactions: The Michaelis-Menten equation

For simple enzymatically catalysed reactions one can assume that enzyme (E) and substrate
(S) form a complex (ES) which decays into free enzyme and product (P) after the reaction.
If all reaction steps are reversible, then the following scheme holds:

E + S
k1−−⇀↽−−
k-1

ES
k2−−⇀↽−−
k-2

E + P
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Often the back reaction of the product P is so slow that it can be neglected:

E + S
k1−−⇀↽−−
k-1

ES
k2−−→ E + P

The efficiency of the enzymatic reaction is determined by the product production rate:

v =
d[P]

dt
= k2[ES] (1)

The formation of the ES complex depends on the concentrations of enzyme E and substrate
S (2nd order kinetics). The ES complex can dissociate to form a product or it can fall back
to free enzyme and substrate:

d[ES]

dt
= k1[E][S]− (k−1 + k2)[ES] (2)

In the case of the very high substrate concentration a stationary state regarding the
concentration of the complex is reached, because the enzyme concentration is the limiting
factor in the reaction kinetics. After addition of substrate the number of enzyme-substrate
complexes would increase but after a while the increasing decay rate slows down this increase
until an equilibrium of the complex concentration is reached. This is the so-called stationary
state approximation

d[ES]

dt
= 0 (3)

It follows that

k1[E][S] = (k−1 + k2)[ES] (4)

[ES] =
k1

k−1 + k2
[E][S] =

[E][S]

KM
(5)

Here, the Michaelis-Menten constant was defined as KM = k−1+k2
k1 .

The free enzyme concentration [E] equals the total enzyme concentration [E0] minus enzyme
bound in ES complexes:

[E] = [E0]− [ES] (6)

Thus

[ES] =
([E0]− [ES]) [S]

KM
(7)

Which can be simplified to

[ES]

(
1 +

[S]

KM

)
=

[E0][S]

KM
(8)

[ES] =
[E0][S]

KM

KM

KM + [S]
= [E0]

[S]

KM + [S]
(9)

From equation 2 we know that:

v =
d[P]

dt
= k2[ES] = k2[E0]

[S]

KM + [S]
(10)
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Finally we obtain the equation describing the speed of enzymatic reaction depending on
the substrate concentration, called Michaelis-Menten equation:

v =
νmax[S]

KM + [S]
(11)

where KM and νmax are parameters that define the kinetic behaviour of an enzyme as a
function of the substrate concentration [S], if [S]�[E]. Those parameters can be determined
in series of experiments in which enzyme concentration is kept constant while substrate con-
centration is varied. Initial reaction rate ν0 is measured and plotted against [S] (Fig. 7).

Figure 7: Michaelis-Menten kinetics. Plot representing enzymatic reaction rate for dif-
ferent substrate concentrations for Michaelis-Menten kinetics.

Due to the hyperbolic shape of this plot it is hard to extrapolate data to infinity for
the determination νmax. For that reason a linear transformation of the Michaelis-Menten
equation is used, where the inverse production rate 1

ν0
is a linear function of the inverse

substrate concentration 1
[S]

1

ν0
=

1

νmax
+
KM

νmax

1

[S]
(12)

Kinetic parameters of enzymatic reaction can be easily extracted by plotting the experi-
mentally determined value of 1

ν0
against 1

[S] (Fig. 8).
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Figure 8: Lineweaver-Burke plot.Illustration of the linear transformation of the Michaelis-
Menten equation to so called Lineweaver-Burke plot.

2.2 Principles of fluoresence microscopy

Radiation of a certain wavelength cannot be used to observe structural details that are much
smaller than the wavelength. The theoretical resolution limit of optical microscopy is given
by the wavelength of the incident light and the numerical aperture (NA) of the microscope
lens system and is described by the Abbe diffraction limit

d =
λ

2nsinθ
(13)

where d is the resolvable feature size, λ is the wavelength of the light, n is a refractive index
of the medium the light travels in and θ is the half-angle subtended by the optical objective
lens. nsinθ is called the numerical aperture (NA) and can reach about 1.4 in modern optics.
For a typical wavelength of 546 nm and a numerical aperture of 1.4 the resolution limit is
approximately 200 nm.

With help of the fluoresence microscopy particles which cannot be detected due to an
bright background can be located. Advantage of this technique are its high resolution and
the ability to work under biologically relevant conditions. However, it is important to notice
that fluorescence microscopy is also subject to diffraction limit. Due to the close to zero
background single molecules of sizes of few nanometers can be detected using fluorescent
labeling techniques but if they are closer to each other than the diffraction limit, they cannot
be individually resolved.

To detect single molecules with a size smaller than the diffraction limit they can be labelled
with fluorescent dyes. Those dyes absorb photons of a certain energy and emit photons with
lower energy. Labelled molecules can be observed by illuminating them with light of the
absorption wavelength. A filter in front of the detection is used to let only the fluorescence
light pass. This leads to an image of the fluorescently labelled molecule on a dark background.
In figure 9 a typical fluoresence microscope is presented.
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Figure 9: Schematics of the fluorescent microscope. A filter set consists of two blocking
filters and one dichroic mirror. In this example the filter set is chosen for the detection of
fluorescein.

One major limitation of fluorescent microscopy is photobleaching - a process in which flu-
orophores lose their ability to fluoresce as they are illuminated. Photobleaching occurs as the
fluorescent molecules are damaged by the electrons excited during fluorescence. Photobleach-
ing can severely limit the time over which a sample can be observed. Several techniques exist
to reduce photobleaching such as the use of more robust fluorophores, minimizing illumination
and use of photoprotective scavenger chemicals.
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3 Experimental procedure

By means of total internal reflection fluorescence (TIRF) microscopy we will perform in vitro
investigations of the interaction between the muscle proteins myosin II and actin in presence
of ATP. The Michalis-Menten equation can be used to determine parameters describing the
enzymatic behaviour of this actin-myosin system. To achieve this, the speed of the actin
filaments, which is a measure for the myosin-ATP reaction rate, will be measured at different
ATP concentrations.

To image actin filaments in this experiment a fluorescent dye called Alexa Fluor 488
conjugated with a phalloidin group is used. The absorbance and fluorescence spectrum of
Alexa Fluor 488 is shown in Figure 10. Phalloidin is a small bicyclic peptide that selectively
binds to polymeric F-actin thereby inhibiting its turnover. Phalloidin is toxic and originally
is produced by the fungus Amanita phalloides. It has first been isolated at the chemical
department of the LMU by Feodor von Lynen and Ulrich Wieland in 1937.

Figure 10: Fluorescence spectrum of Alexa Fluor 488. Excitation spectrum is shown
in light green, emission spectrum in dark green.

3.1 Proteins used during the assay

• Heavy meromyosin (HMM): Myosin isolated from New Zealand white rabbit skeletal
muscle was used to prepare HMM. Thaw aliquots slowly on ice and keep them on ice.
• Actin solution: Actin purified from acetone powder from New Zealand white rabbit

skeletal muscle. It is polymerized and labeled with Alexa488-phalloidine. Keep actin
aliquots on ice and in the dark. Handle with care as phalloidin is toxic.
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3.2 General Remarks

• Label all tubes
• Required formulas: c=n/V=m/(MW*V)
• Definitons: 1M=1mol/l; [MW]=g/mol

3.3 Preparations

1. Prepare 100mL AB- buffer pH 7.4. This is a basic protein buffer used in the experiment.
Calculate amount (g) of Imidazole from theoretically determined molecular weight given
in g/mol. KCl (3M), MgCl2 (0.5M) and EGTA (0.5M) are present as stock solutions,
calculate the appropriate dilutions. Adjust pH.

AB buffer, pH 7.4:
• 25 mM Imidazole hydrochloride (MW=68,08g/mol)
• 25 mM KCl
• 4 mM MgCl2
• 1 mM EGTA (ethylene glycol tetraacetic acid)

2. Degas 10 ml of AB- buffer for 20 min in a vacuum exsiccator and store in a syringe.
3. Thaw 0,1M ATP, 1M DTT, 1mg/mL Catalase, 5mg/mL Glucose oxidase, 50mg/mL

BSA and 150mg/mL Glucose on ice.
4. Take one aliquot HMM solution (2 mg/ml, 6µM) from −80◦ freezer and thaw on ice.

Take phalloidin labeled fluorescent actin (Alexa Fluor 488) and store on ice.
5. Prepare AB-/BSA/GOC/DTT buffer (Scavenger) and store in a syringe. Catalase,

glucose oxidase and glucose slow down bleaching of dye molecules.
• 1 mL degassed AB-
• 10 µL BSA
• 10 µL Glucose oxidase
• 10 µL Catalase
• 10 µL Glucose
• 10 µL DTT

6. Directly before experiment: Prepare 100µl of AB+/BSA/GOC/DTT buffer with dif-
ferent ATP concentrations (2000, 400, 100, 50, 20, 10, 5 µM): For the 2 mM ATP
concentration add 2µL of 0.1 M ATP stock directly to AB-/BSA/GOC/DTT buffer.
Dilute ATP stock solution (0.1 M) in AB-/BSA/GOC/DTT buffer to generate 1 mM
ATP solution and add appropriate amounts (x µL ) to the AB-/BSA/GOC/DTT.

7. Dilute HMM stock solution (2mg/mL) to 0,2mg/ml in AB-. Dilute actin stock solution
(50µM) to 10nM and vortex it approx. 30sec-1min to get short filaments.

3.4 Assembly of Nitrocellulose coated Flow cells

Flow cells for fluorescence microscopy observations have to be fabricated. Firstly, cover glass
slips are modified with a thin layer of nitrocellulose. Nitrocellulose has a non-specific affinity
for amino acids and can be used to immobilize myosin molecules on the surface. As a second
step, glass slide and a cover glass slip are fixed on top of each other with double sided
adhesive tape, as shown in Fig. 11. The space between glass plates has a volume few tenths
of micrometers and can be filled up with the liquid sample due to capillary forces.
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Protocol:
• Dilute 1,5µL Nitrocellulose stock solution in 100µL Amylacetat
• Pipette 2,5µL Nitrocellulose dilution on coverslip
• Use pipette tip to spread solution on coverslip
• Mark top left with marker
• Stick double sided tape on glass slide (cut tape into two pieces, distance 0.5cm means

approx. 10µL Volume)
• Stick Nitrocellulose coated cover slip with coated side down on glass slide
• Store them in a box

Figure 11: Flowcell preparation.

3.5 Experimental Procedure

1. Switch on microscope and prepare settings.
2. Infuse flow cell with 0.2mg/mL HMM solution (10-20µL) by using a pipet. Incubate

for 3 min.
3. Wash with AB- buffer.
4. To passivate the surface infuse flow cell with 50mg/mL BSA. Incubate for 3 min.
5. Wash with AB- buffer.
6. Infuse flow cell with 10nM short actin. Incubate for 3 min.
7. To wash out unbound actin filaments infuse flow cell with AB-/BSA/GOC/DTT buffer.
8. Place flow cell onto the microscope and image. At this point you can already observe

binding of actin filaments.
9. Add AB+/BSA/GOC/DTT with the lowest ATP concentration.

10. Image on the microscope and record videos with appropriate settings (e.g. 300msec
intervals with 80ms exposition). Make sure that the videos are saved properly.

11. Continue with other ATP concentrations by repeating steps 7-10.

3.6 Measurements

Think about suited microscope settings, e.g. excitation wavelength, exposure time, objective
size and type (immersion oil or air). Adjust the objective such that actin filaments running
over myosin are in the focal plane and become visible.
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Perform the following experiments:
• Determine the kinetic of the enzymatic hydrolysis of ATP by myosin. Record the videos

of the moving actins in liquid chambers filled with different ATP-concentration (2000,
400, 100, 50, 20, 10 and 5µM).
• Determine how the temperature influences the kinetics of gliding assay. Perform the

measurement of actin speed in room temperature and after cooling the flow chamber
on ice.
• Estimate the usage of ATP in the measured system. After measuring the first concen-

tration of ATP keep the fluid chamber in the fridge and measure it again at the end of
the day. How did the speed of the actin filaments change?

4 Evaluation of the results

• With help of ImageJ (Fiji) or comparable software measure the speed of the actin
filaments in recorded videos. You can compare different manual and automatic tracking
softwares to get acquainted with advantages and disadvantages of both.
• Make a histogram of the length distributions of actin filaments considered for the anal-

ysis
• Draw a graph of the actin filamets speed versus the ATP concentration. Interpret the

outcome with help of the Michaelis-Menten equation. Determine the KM and νmax.
What assumptions have to be met in order to use Michaelis-Menten kinetics?
• Interpret the effect of the temperature on the reaction.
• Estimate changes in ATP concentration during the reaction. How much ATP is used?
• For the experts: you can use the FAST algorithm from the Spudich Lab at Stan-

ford (http://spudlab.stanford.edu/fast-for-automatic-motility-measurements/) to ana-
lyze the behavior of single actin filaments in more detail. Further information about the
algorithm can be found in the original publication: Aksel et al. 2015 ”Ensemble Force
Changes that Result from Human Cardiac Myosin Mutations and a Small-Molecule
Effector” Cell Reports 11:910-920.

4.1 Evaluation with Fiji

If the MTrackJ Plugin is not already installed in Fiji, download it from https://imagescience.org
/meijering/software/mtrackj/

• Merge Frames: → Image → Stacks → Tools → Grouped Z Project
• Plugins → Tracking →MTrackJ
• Start with → Add; Stop this track by double click with left mouse pad (fast)
• Delete point → Delete; move mouse to point (similar with → Move)
• Getting Data: → Measure; Two Tables: Tracks + Points; Use Tracks
• → Movie
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